
El presente Tutorial incluye unas nociones sobre como trabajar con Match, los archivos que 
usa quedan instalados con el  programa. La información ha sido traducida desde el  propio 
manual (en pdf) incluido también en el programa.

Se recomienda cuando se plantee alguna duda sobre el manejo el buscar el archivo de ayuda 
“en línea” de Windows lo que se hace desde la barra de menús bajo Help, la información está 
totalmente ampliada. Es buena práctica el imprimir el manual y la ayuda de Windows para 
tener las referencias a mano.

En el Tutorial se incluyen las pantallas reales surgidas mediante el manejo del programa, esto 
no significa que sean iguales a las que se pueden obtener pues puede depender de algún 
factor de configuración, de todas formas la configuración usada ha partido desde los ajustes de 
fábrica.  Caso  de  tener  que  usar  otra  base  de  datos  que  no  sea  la  misma PDF2_49   el 
resultado también puede variar, pero en esencia el procedimiento planteado es válido.

Traducción por: Santiago. Rodríguez 
18 diciembre de 2006 

(revisada 4 de mayo de 2008)
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TUTORIAL: INSTALACIÓN 

El  programa  match!  está  pensado  para  la  identificación  de  fases  partiendo  de  distintos 
archivos de difracción de polvo obtenidos por los aparatos de rayos X. A estos archivos de 
datos les denominaremos archivos fuente.

La instalación del programa es automática, el disco contiene un auto arranque en el que se 
puede seleccionar la instalación de Match!  y de versiones “demos” de otros programas de la 
Casa “Cristal Impact”. La versión base adquirida en febrero de 2006 es la 1.3b y por tanto se 
debe actualizar periódicamente; puede procederse a la actualización de los archivos mediante 
conexión  con  la  página  http://www.crystalimpact.com.  desde  ahí  puede  descargarse  el 
archivo  correspondiente, guardarse en disco y proceder a la actualización; basta con instalar 
el de la última versión (a 4 de mayo de 2008, la última versión es 1.8). 

El archivo descargado es de formato .zip autoextractable, por lo que para su instalación debes 
seguir estos pasos:

1 Si estás usando el Match cierra el programa y salva los documentos.

2 Haz doble click sobre el icono y verás como se activa el descompresor y solicita que se  
descomprima (unzip) en el directorio de instalación de match. ASEGÚRATE DE QUE  VA A 
DESCOMPRIMIRSE EN LA RUTA DONDE TU HAS INSTALADO EL MATCH por ejemplo 
(“C:\Archivos de programa\Match!”) ya que en inglés figurará “C:\Program files\Match!”. una 
vez indicada  la  ruta la  descompresión  y  actualización  son automáticas.  Las  pantallas  que 
observarás son las siguientes:

   

Si dudas sobre la  ruta de instalación puedes buscarla a través del 
botón Browse…, en cualquier caso al acabar se mostrará el aviso que 
indique el número de archivos modificados por la actualización.
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3 Reinicia el Match.

Si  vas a  realizar  la  instalación  por  primera vez y  dispones de una actualización,  una vez 
instalado  el  programa  puedes  ejecutarla  sin  necesidad  de  arrancarlo,  después  reinicia  el 
ordenador (es buena costumbre en Windows) y arranca el programa, la pantalla que verás 
inicialmente  indicará la versión.

En el momento en que la pantalla de bienvenida se cierre, el programa intentará conectar para 
averiguar si existen actualizaciones, mostrará

En el  caso de que la  versión se haya instalado con la 
última actualización se cerrará la pantalla. Si no hay línea 
disponible para Internet o no puede conectar aparecerá 
este aviso 

Y bastará con aceptar para iniciar normalmente la sesión

Si no se quiere que Match compruebe la actualización cada vez que abra el programa, basta 
con ir al menú Tools / Options y en la pestaña General desactivar la casilla de verificación 
“Automatically check for online updates”
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La  identificación  de  fases  (compuestos,  especies  y  elementos  con  estructura  cristalina 
recogidos en los difractrogramas) se hace realmente por comparación con los patrones de 
difracción  recogidos  una  base  de  datos  relacional.  El  “International  Centre  for  Diffraction 
Data”  (ICDD)  comercializa  una  base  de  datos  denominada  PDF  (Podwer  Diffraction  Data 
Base) en sus distintas versiones PDF-2 y desde el 2005 la PDF-4. Por tanto el usuario tendrá 
que disponer de alguna de estas versiones.

Match requiere realizar un índice de la versión de la base instalada para poder obtener las 
entradas correspondientes de los patrones de difracción almacenados y compararlos con el 
difractograma procesado de nuestra muestra. 

Este proceso de obtención se llama “indexado” de la base y es lo primero que el programa 
EXIGE.

Si se indica que no se cierra el programa. Afortunadamente una vez instalada la base PDF 
Match puede rastrear su posición y proceder al indexado de manera automática. Veremos las 
siguientes pantallas.

Aquí se muestran tres opciones, una supone que le programa ya trabajo con una base de 
datos (Previously used PDF-2) e indica la ruta, esta opción estará solo disponible si ha sido 
cierta, por ejemplo si como en mi caso reinstalé el programa.
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La opción por defecto es la búsqueda automática de la PDF-2 y 
si se ha reinstalado la PDF o actualizado o incluido una nueva 
base se puede buscar mediante una selección manual. Lo mas 
cómodo es hacerlo automáticamente

El tiempo de indexado depende de la memoria y potencia del ordenador, desde unos minutos 
hasta casi una hora (en los Pentium II). 

             

Al final se muestra el aviso de conformidad de uso del programa.

Por fortuna este proceso solo se debe realizar cuando se inicia por primera vez o si se quiere 
cambiar de base de datos o si se quiere actualizar o usar una base de datos realizada por el 
usuario. 

En el proceso no se escribe nada ni se modifica nada en la base de datos solo se abre un 
archivo en el directorio de Match por lo que las bases de datos que usemos pueden incluso 
permanecer en un dispositivo externo ( un pendrive o disco externo o incluso un CD-ROM). 
Para la casuística de instalación podemos ver el manual del Match abriéndolo desde el menú 
Help.
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TUTORIAL 1: COMIENZO RÁPIDO 

El planteamiento es el siguiente: Intentaremos identificar el difractograma de un compuesto 
que es una sola fase sencilla usando la base de datos general.

Una  vez  indexada  la  base  de  datos  y  en  las  sucesivas  sesiones  la  apertura  del  Match 
presentará  la  interfase,  principalmente  tiene  tres  áreas  principales,  la  gráfica,  la  de 
presentación de los resultados de búsqueda y la de información de datos de los patrones 
(picos e intensidades o fichas o informes)

El primer paso para iniciar una sesión es importar el 
archivo  que  contiene  los  datos  del  difractograma, 
usaremos  no  el  botón  general  de  abrir  sin  el  de 
“importar”.

También puede iniciarse mediante la pulsación de Ctrl.
+I  o  mediante  la  secuencia  del  menú  File  / 
Import /Diffraction data
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del programa
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Se abrirá un cuadro que permitirá seleccionar el archivo fuente, en nuestro caso buscaremos 
en la ruta C:/Archivos de programa /Match /Tutorial / session1.dat.

El tipo de archivos fuente que match puede abrir, se obtiene en el cuadro desplegable Tipo y el 
correspondiente  a ala  primera sesión es del  tipo Perfil  (start,step,end,intensities)  extensión 
*.dat. Antes de abrirlo el programa solicita confirmación de los parámetros experimentales

  

La longitud de onda de la radiación o algún otro parámetro según el tipo de archivo fuente que 
abramos, se dispone también de un menú desplegable con todos lo tipos soportados desde el 
cromo hasta el wolframio. 

Algún tipo de archivo fuente como los obtenidos por difractores Phillips  pueden llevar esta 
información registrada y cargan el gráfico directamente. Pulsaremos OK y si los datos han 
recogido el perfil del difractograma podremos verlo en el área de gráficos.
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Además la barra de botones del programa se activará

El botón que usaremos para iniciar el procesado del difractograma experimental 
y  el  cotejo  con  la  base  de  datos  cargada  es  el  llamado  “SearchMatch”, 
representado por el símbolo del programa. Automáticamente comienza todo el 
proceso lo que percibiremos en la interfase porque…
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124564  patrones de la 
base de datos (cotejo)
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Al procesar el archivo fuente se mostrará en el área de gráficos el patrón experimental (los 
picos como un diagrama de barras cuya altura mide su intensidad) y aparecerá en la “Lista de 
picos” la lista de valores “2θ” y de intensidades “I” junto con el valor “FWHM“("Full Width at Half 
Maximum"). 

El  proceso  del  perfil  experimental  de  datos  se  hace  mediante  un  algoritmo  en  el  que 
inicialmente se aceptan todas las intensidades y después se eliminan aquellos  picos cuya 
intensidad  o “valor FWHM” no  superen un determinado valor  umbral;  es  decir  I y  FWHM 
constituirán los parámetros con los que nuestro programa construirá el patrón experimental, los 
valores umbral que permitirán tomar la decisión pueden modificarse en caso de realizar un 
proceso con mas sensibilidad.

El resultado de las comparaciones se muestra en la “Lista de resultados”, aparecerá en cada 
fila los datos de los patrones que mejor coinciden ordenados por un parámetro la “Figure of 
Merit” FoM, que asignará un valor de 1.000 si la coincidencia es total (identificación positiva) y 
que disminuirá conforme las posiciones de los picos cotejados o las intensidades se alejen 
mas del patrón experimental obtenido de la muestra. Estas filas son las entradas de la base.

Ahora  solo  falta  decidir  cual  o  cuales  de  las  entradas  coincide  mas  con  nuestro  patrón 
experimental;  si  situamos el  cursor sobre el  nombre del  primer compuesto y hacemos UN 
SOLO CLICK habremos “marcado” la primera entrada y podremos observar lo siguiente
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Por convenio la información referente a nuestro patrón experimental se representará en azul y 
la  información  al  patrón  que  estemos  examinando  en  otro  color,  en  la  columna  color  se 
asignará uno (en este caso el rojo).

Cada  intensidad  de un pico  aparece “asignada”  a  una  posición  2θ de  un  pico  del  patrón 
experimental, la asignación puede verse de manera gráfica representada por pequeñas líneas 
bajo el eje de ordenadas de la representación unidas por una pequeña línea.

Como el grado de coincidencia es razonable, y sabemos que la experimentación corresponde 
aun solo compuesto con una sola fase podemos suponer que se trata del  Li2TbF6. 

El paso siguiente es confirmar la selección, para ello podemos señalar el nombre del 
compuesto y hacer DOBLE CLICK sobre él, o marcarlo con un clic sencillo y pulsar 
en el botón de seleccionar/deseleccionar

El compuesto quedará seleccionado la información quedará registrada en la pantalla y si se 
quiere  inspeccionar  otra  entrada  basta  con  marcarla,  por  ejemplo  el  siguiente  se  verá  la 
pantalla.

Manuales del departamento de Análisis Químico – diciembre 2006 -

Posiciones de nuestro 
patrón siempre azules

Posiciones del patrón 
comparado

Esta línea pequeña que los une 
indica que estas posiciones han sido 
relacionadas.

Los datos de la entrada roja están 
confirmados

Los datos de la entrada verde se están 
comparando en ese momento

En la segunda comparación el 
programa asigna automáticamente 
el verde como color para la ficha 
00-078-2261
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Una vez decidida  la  entrada que identifica nuestro 
difractograma,  seleccionaremos  el  menú  File  / 
Finished o pulsaremos Ctrl.+F acción que abrirá el 
cuadro  de  diálogo  que  indica  como  finalizará  la 
sesión,  por  defecto  el  programa  imprimirá  un 
informe,  guardará  la  sesión  y  cerrará  Match. 
También tiene la posibilidad de guardar una lista de 
picos para permitir otras sesiones.

El informe que match imprime puede verse en el área de picos, basta con pulsar el botón 
“Report”, y configurarse mediante el cuadro de opciones.

  

En el  programa el  botón del  martillo  abre un cuadro general  de opciones cuyas pestañas 
permiten la configuración de distintas secciones. La pestaña “Report” se abre directamente con 
la pulsación indicada.
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TUTORIAL 2: RESTRICCIONES 

Un aspecto importante en el trabajo de identificación de muestras es el aplicar el conocimiento 
adicional a la información de los rayos X que se pueda obtener de la muestra; esto permite 
limitar el número de patrones a cotejar con el patrón procesado de nuestra muestra, y tiene 
ventaja,  pues además de hacer la búsqueda más rápida elimina posibilidades extrañas de 
coincidencia. 

Las bases de datos como PDF son muy extensas y contienen las “Fichas” de los patrones; 
como son bases relacionales precisamente sus propios datos pueden servir para encontrar las 
entradas y se puede obtener información precisa de un patrón. 

Match aprovecha la relación de datos y presenta un cuadro de diálogo llamado restricciones 
(Restraints) que está compuesto por siete categorías marcadas en sus secciones.

• Composición (datos  de presencia o ausencia de elementos)

• Cristalografía (datos del sistema cristalino, celda unidad y grupo espacial)

• Propiedades físicas (datos de densidad, color, nombre mineral..)

• Difracción (datos de calidad de la difracción, picos individuales, rangos…)

• Bibliografía (datos sobre el autor, revista, año de publicación)

• Database/Subfiles (acceso a bases parciales de PDF o particulares)

• Entradas (selección por código en las bases de datos)

Si en cada sección marcamos o indicamos unos pocos datos, estos se combinarán de manera 
lógica (AND u OR) y el cuadro Restraints la usará para indicar de todos los patrones de la 
base de datos sobre la que actúe cuales cumplen con el conjunto las condiciones impuestas 
en las secciones. Se habrá conseguido una Búsqueda ajustada a nuestra necesidad de cotejo.

El  tutorial  describe  las  posibilidades  de  las  secciones  del  cuadro  Restraints  y  realiza  un 
supuesto de búsqueda. Como no estamos analizando ningún difractograma no importaremos 
ningún archivo fuente, en vez de ello vamos a intentar resolver un ejemplo

¿Sería  posible  averiguar el  número de ficha de un  silicato  cuya  densidad calculada  está 
comprendida  entre  2.65  y  3.0  g/cc  y en  cuya  composición  se  encuentra  algún  metal  
alcalinotérreo y cuya estructura cristalográfica posiblemente sea hexagonal o trigonal y que se 
clasificó originariamente dentro de las fichas  ICSD (Inorganic Cristal Structure Database)?

Abriremos el programa MATCH  o iniciaremos un nuevo documento (seleccionamos el menú 

File > New) o su icono.
Podemos abrir el cuadro de restricciones mediante. Ctrl. + R. o mediante el menú 
Search > Restraints, o con el botón de acceso directo a restricciones “Restraints” 
(el embudo). 
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Este cuadro contiene una serie de “pestañas” cada una por cada sección de datos, en las que 
se permiten introducir condiciones que permitirán restringir la búsqueda en toda la base PDF. 

Por defecto la pestaña abierta es la de “Composition”, tiene forma de tabla periódica y sirve 
para introducir los datos correspondientes a la presencia o ausencia de elementos en nuestros 
compuestos.

Esta tabla usa un mecanismo de restricción basado en un código de colores.

Para cada elemento puedo definir cuatro posibilidades o estatus de presencia o ausencia, el 
código es este:

1. Los elementos de fondo ROJO están EXCLUIDOS en nuestra búsqueda y no figuran 
en la composición de la especie buscada.

2. Los elementos de fondo VERDE están INCLUIDOS y figurarán en la composición de la 
especie buscada.

3. Los  elementos  con  fondo  AMARILLO pueden  estar  presentes  o  no  en  nuestra 
búsqueda, es decir se definen como OPCIONALES.

4. Los elementos con fondo AZUL AL MENOS UNO de ellos (ALGUNO) estará presente 
en cada resultado de la búsqueda.
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Por defecto la tabla aparece con todos los elementos como opcionales (amarillo), pero como 
es muy posible que solo quiera considerarse la presencia de algunos pocos, es más cómodo 
cambiar  toda la tabla en rojo (usando el botón “Toggle”) y después cambiar el estatus de los 
pocos elementos considerados.

Si se quiere volver a la condición de apertura con todos los elementos como posibles se puede 
pulsar el botón  “Reset all”.

Para nuestro caso puede procederse de esta manera

1. Pulsa  Toggle y  excluye  a  todos  los  elementos,  pasarán  de  fondo amarillo  estatus 
”Optinal” (opcional) a fondo  rojo;  estatus “None” (ninguno).

2. Verifica la casilla “All” (todos) en verde y cada vez que pulses sobre un elemento su 
fondo será verde, en nuestro ejemplo puesto que buscamos un silicato, el oxígeno y el 
Silicio deberán ser “verdes”

3. Los alcalinotérreos serán opcionales, pero no sabemos cual o cuales de ellos, al menos 
sabemos que el silicato contiene algún metal alcalinotérreo luego su estatus será el 
correspondiente  a  la  casilla  “Any”  (alguno);  marcamos  la  casilla  y  sobre  los 
alcalinotérreos  o  sobre  el  encabezamiento  “2a”,  la  columna  del  berilio  al  radio, 
cambiará su color de fondo del rojo al azul.

Si lo hemos hecho bien la tabla deberá aparecer como sigue:

Hay  mas  posibilidades:  existe  un  área  en  la  tabla  llamada  “Element  count”  que  permite 
establecer el número de elementos, como criterio de búsqueda, para nuestro compuesto o 
fase, así introduciendo un número en el campo correspondiente al valor mínimo indicaríamos 
el número mínimo o total de elementos, pero si queremos indicar un número aproximado lo 
haremos mediante un rango,  usando por este orden el  campo  Min y después  Max.  como 
vemos en los ejemplos

Introducimos el valor 4 en el cuadro 
Min, automáticamente el cuadro Max 
coloca el mismo valor, así estaremos 
buscando  compuestos  con  un 
máximo de 4 elementos

El valor 4 se ha introducido en el cuadro 
Min,  automáticamente  el  cuadro  Max 
coloca  el  valor  4  pero  si  luego 
introducimos  7  como  valor  en   Max 
estaremos  buscando   compuestos  que 
contengan entre 4  y 7 elementos
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La fórmula o parte de ella puede ser también un valor con el  que realizar  una restricción, 
usaremos el campo “Formula sum” que presenta una caja de texto.

En la caja de texto puede escribirse directamente la fórmula total  de un compuesto,  si  se 
quiere introducir mas de una fórmula total se puede hacer separándolas por punto y coma el 
programa entenderá que es una u otra u otra…

Como puede ser que se dude en la sintaxis de estas fórmulas, se ha dispuesto de un 
botón especial llamado “questbox”  que facilita una lista de ayuda.

Desde aquí seleccionando una o varias y pulsando OK se colocarán automáticamente en el 
cuadro de texto.

Usando el botón de la estrella verde llamado de “búsqueda de fragmentos de texto” 
podemos  escribir  la  fórmula  de  la  especie  o  una  parte  de  ella,  por  ejemplo  si 
escribimos  Re  el  programa  entenderá  que  se  buscan  compuestos  cuya  fórmula 
contenga el renio

Por último este botón borrará cualquier contenido introducido en el cuadro de texto

Para  introducir los datos referentes a la ficha antigua, pulsaremos la pestaña “Bibliography”,

Aquí  se pueden introducir  valores  para  la  búsqueda  por  fecha de publicación  From/Equal 
permite introducir un año concreto o iniciar un posible período combinándolo con To (hasta).
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El autor la revista o el código se introducen mediante cuadros de texto y puesto que esos 
datos  están  indexados,  se  puede  acceder  a  su  lista  alfabética  mediante  sus  botones 
“questbox”, así no es necesario conocer una bibliografía “exacta”

En  nuestro  caso  sabemos  que  el  material 
buscado pertenecía a las fichas ICSD; usaremos 
el questbox del texto Journal y el único texto que 
se refiere al ISCD es el mostrado, se indica que 
el número de fichas que podríamos encontrar es 
de 42053.

Aceptaremos esta sugerencia y pulsaremos OK. 
El texto  completo se transfiere a nuestro cuadro

No obstante podemos dudar  si  esa sintaxis  es 
válida para remediarlo…

Observamos que también se puede usar un fragmento del texto, si pulsamos el botón de la 
estrella verde e introducimos como texto ICSD posiblemente se produzca el mismo resultado. 
Si  quisiéramos  combinar  nuestras  posibilidades  podríamos  seleccionar  ambos  textos 
separados por punto y coma
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Una cuestión mas, el programa distingue entre mayúsculas y minúsculas pero en el modo de 
búsqueda de fragmento de texto no las distingue. Usaremos esta última posibilidad y daremos 
por completados los datos de la sección.

Los CODEN son los códigos abreviados de las revistas y pueden verse usando su questbox.

Podemos iniciar ahora la búsqueda de datos pulsando 
“Retrieve”,  la respuesta es este cuadro en el  que nos 
anuncia  que cruzando las dos secciones encontramos 
244 posibilidades. 

Si  aceptamos se producirán dos  cosas,  en la  lista  de 
resultados veremos la respuesta de las fichas y además 
las  244  entradas  se  almacenan  en  una  “memoria  de 
restricciones”.

No  obstante  244  posibilidades  son  muchas  aún. 
Podemos mejorar  la  búsqueda con más datos.  Por  el 
momento  aceptamos  y  veremos  aparecer  la  lista  de 
resultados la primera entrada es 00-086-0932 (Diopsido)

Las  entradas  permanecen  en  la 
memoria, luego podemos abrir de nuevo 
el  cuadro  de  restricciones  si  tenemos 
más  información;  los  datos  de 
cristalografía se pueden introducir desde 
la pestaña “Cristallography”.

Como sabemos que podía pertenecer al 
sistema exagonal o trigonal, nos bastará 
habilitar  solo  esa  casilla  para  que  la 
condición  se  cumpla,  una  vez  hecho 
volvemos a pulsar Retrieve. 
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Esta  vez  el  cuadro  de  dialogo  dará  la 
posibilidad  de  combinar  las  nuevas 
restricciones con las entradas guardadas en 
la base anterior.

El  cuadro  nos  indica  que  del  sistema 
hexagonal  o  trigonal  ha  encontrado  12067 
posibilidades  pero  si  cruzan  esas 
posibilidades con las restricciones usadas en 
la búsqueda anterior, solo serán posibles 6. 

Esto es un número más que razonable luego 
aceptamos,  podremos  ver  en  la  lsita  de 
resultados  las  fichas  de  6  silicatos,  tres  de 
calcio, uno de bario y uno de calcio y bario

Podemos afinar  más nuestra búsqueda pues aún 
sabemos  que  el  silicato  buscado  tiene  una 
densidad entre 2,65 y 3,00 g/cc; volvemos a abrir el 
cuadro  de  restricciones,  vamos  a  la  pestaña 
“Properties”  e  introducimos  estos  valores  en  las 
casillas correspondientes a densidad calculada.

 

El  resultado  de  la  combinación  de 
TODAS  las  restricciones  es  UNA 
ÚNICA ENTRADA.
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Corresponde a la ficha 00-077-0420 según la numeración actual, y es un silicato de calcio.

Podemos conseguir la ficha completa, que aparecerá en la ventana de informes, 
marcando la entrada  y a continuación pulsando en el botón

En  ese  informe  podremos  comprobar  si 
nuestras  restricciones  se  cumplen;  por 
ejemplo la densidad calculada corresponde al 
valor  2.967 g/cc.  Y se  puede  ver  los  datos 
correspondientes  a  la  antigua  clasificación 
ICSD.  Era la ficha 039124
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TUTORIAL 3: UNA MEZCLA DE COMPUESTOS

El análisis de una mezcla de compuestos no es más complicado que el de una fase simple, 
sobre todo si son productos sintéticos; en el supuesto que nos ocupa se trata de una “mezcla  
de varios minerales”  según la información que tenemos y preparada artificialmente.

Iniciaremos un nuevo documento (seleccionamos el menú File > New) o su icono.

Abriremos el cuadro para importar archivos desde su menú o por el botón y en el 
directorio tutorial seleccionaremos los datos del tipo Phillips/PANanalitical raw 
data (*.rd) veremos la posibilidad de abrir el archivo “session3.rd” y lo abrimos.

Los archivos .rd incorporan la  información del  tipo de ánodo usado y la  longitud  de onda 
(CuKα1), por lo que directamente abrirán su difractograma, además como puede observarse la 
información aparece en la barra de información del programa (bajo el gráfico)

El  paso  siguiente  es  usar  la  información  adicional  para  establecer  restricciones  en  la 
búsqueda.  Por tanto bien seleccionando el  botón “Restraints”,  o desde el  menú  Search > 
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Restraints o  pulsando  Crtl+R abriremos  el  cuadro  de  diálogo  correspondiente.  En  este 
seleccionaremos la  pestaña “Database/Subfiles”  y verificaremos solo la  casilla  de Minerals 
después pulsamos “Retrieve” y nos informará del número de entradas disponibles.

Al aceptar podremos ver la información en la “barra de información del programa” ya descrita 
(esquina inferior derecha)

Debe compararse esta figura a la anterior, obsérvese el cambio del icono y del texto, indicando 
el número de entradas encontradas, el “cilindro azul” con 124564 correspondería a toda la 
base de datos ahora ha cambiado a un “embudo” con 13935 indica que se han realizado 
restricciones de búsqueda.

Según la base usada el número de entradas puede cambiar, si se usa un paquete PDF 4 o 
PDF2 de 2005 habrán unas 17000 entradas válidas

Pulsando el correspondiente botón, mediante el menú Search > Search-Match o 
mediante la secuencia de teclas Ctrl.+M

Mientras dura el proceso puede verse en la barra de información que se ha efectuado una 
corrección de 0.01º de ángulo en los valores 2θ 
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Al acabar nos dirá que ha encontrado 72 entradas; estas tienen una FoM superior a 0.60 la de 
máxima FoM (0.8511) es un óxido de silicio (cuarzo) de referencia 00-085-0797 
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Si buscamos entre las entradas, veremos como el óxido de cuarzo, el aluminio y la calcita 
están entre las seleccionadas, aparecen distintos patrones con mejor o peor coincidencia, pero 
se puede decir que esas especies son probablemente las existentes.

No obstante puede verse algo extraño, el patrón de cuarzo 00-085-0797 tiene un valor FoM 
0.85 mientras que el patrón de cuarzo 00-046-1045 la tiene de 0.68. No obstante los picos en 
ambos pueden verse que no son tan diferentes. Hay una explicación para ello; si nos damos 
cuenta el patrón 00-046-1045 tiene registrados mas de treinta picos  entre  87.44º  y  144.12º 
mientras que nuestro patrón experimental solo abarca hasta 90º, por tanto a la hora de dar un 
valor de coincidencia resulta peor del que le pudiera corresponder.

Para  corregir  este  problema  MATCH tiene  la  utilidad  que  permite  restringir  la 
comparación  de  picos  solo  al  rango  de  valores  2θ experimental;  “Restrict  to 
experimental range” que se activa por el botón 

El efecto provocado puede verse en el cotejado del patrón 00-046-1045, aparece una banda 
naranja desde los 90º en adelante 

Y el valor de su FoM pasa a 0.8614, con lo que la lista de patrones se reorganiza. Es una 
buena idea realizar otro cotejado; pulsa Ctrl+M.

Ahora las primeras 14 entradas de la lista de patrones corresponden al cuarzo con valores 
FoM desde 0.8648 hasta 0.8517, la siguiente entrada es un óxido de aluminio el 00-46-1212 
con FoM 0.8401, y por debajo aún existen tres patrones de cuarzo.

Para simplificar la búsqueda el programa dispone de una herramienta más, es el 
botón “Automatic residual searching” está situado debajo del anterior. Pulsémoslo
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Ahora  puesto  que  la  especie  que  mas  posibilidades  tiene  es  el  cuarzo  00-086-1560 
procedemos a su validación.

Automáticamente todas las especies similares desaparecen de la lista de patrones, que toma 
estos valores

Si tuviéramos que seleccionar otro patrón sería de óxido de aluminio, pero si observamos la 
lista veremos la columna Quant (%) en ella aparece (n.a.) o (I/Ic avail. ) aquellos patrones que 
poseen el dato del cociente I/Ic pueden usarse en una valoración cuantitativa, así que elegiré 
para validar el óxido de aluminio de FoM 0.8200 en vez del de 0.8410 y el carbonato 0.8144 en 
vez de el de 0.8181. Además se puede seleccionar un óxido de hierro de FoM 0.6625, con ello 
la columna Quant (%) sumará 100.0 y no se presentarán más fases. El resultado será 
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TUTORIAL 4: UN CASO REAL

Aunque parezca increíble entre mayo y junio de 2002…

…Y organizado por J.-M. Le Meins, L.M.D. Cranswick & A. 
Le Bail, se realizó un concurso por Internet en el que se 
plantearon  cuatro  preguntas  sobre  cuatro  muestras  de 
difractogramas reales, facilitando los archivos fuente y se 
solicitó a los participantes que indicasen su composición.

Esto tendría que poner de manifiesto que programas eran los más usados por los estudiantes 
y profesionales que trabajan con XRD. 

Actualmente la página principal aún se mantiene en Internet, se puede acceder sin más que 
buscar “Serach Match Round Robin”.  La traducción es esta:

Paso 1 – Descarga de datos y planteamiento.

Los datos en distintos formatos se obtienen en un zip de nombre smrr.zip, al descomprimirlo 
se obtienen 4 directorios, cada uno contiene archivos en formatos DAT CPI,  UDX, GSA y 
RAW de la misma muestra. Pero se plantean 4 muestras (samples) diferentes

Sample 1 – Un geólogo nos pide: ¿Por favor puede identificar las fases de este polvo? 
Posiblemente no sea una fase única, el difractor es una cámara de geometría. Bragg-
Brentano - Cu-Kα.

Sample 2 – Un  químico:  ¿Puede  alguien  indicarme si  esta  muestra  sintética  está 
descrita en la PDF ? De hecho parece una única fase  el difractor es una cámara tipo 
Transmission geometry - Capillary - Cu-Kα-1. 

Sample 3 - El jefe de un laboratorio farmacéutico solicita: ¿Por favor sería posible 
identificar las fases en esta muestra de polvo mediante una búsqueda en la PDF? el 
difractor  es  una  de  tipo  Bragg-Brentano  -  Cu-Kα.-  El  polvo  de  la  muestra  se  ha 
dispuesto con orientaciones preferentes, no al azar.

Sample 4 - El Director de laboratorio dice: He recibido una muestra  fabricada en  un 
proceso industrial, Por favor ¿Puede realizar un patrón y cotejarlo con la base PDF? el 
difractor es una cámara de geometría. Bragg-Brentano - Cu-Kα.

Paso 2 – Información adicional sobre las muestras 

Sample 1 - Contiene:  Ca,  Fe,  Al,  P,  Si,  O,  C e H,  y algunas trazas de elementos, 
muestra procedente de  Rapid Creek, Yukon, Canada. 

Sample 2 - Contiene: Si, O, quizá F,  y una molécula orgánica. 

Sample 3 – Formula  molecular: C13H10N2O4, posiblemente formas polimorfas. 
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Sample 4 - Contiene: Pb, S, O, trazas de C e H. El fabricante indica que procede de 
una planta de baterías de ácido – la muestra es una mezcla de óxido de plomo y ácido 
sulfúrico, secada en medio húmedo a temperatura entre 50 y 90 ºC.

Los archivos  fuente  de estas  muestras  están en un disquete  bajo  el  nombre  SMRR  pero 
nosotros usaremos la  correspondiente a la  muestra 4 que está en el  directorio  Tutorial > 
“session 4.dat” que es un archivo de tipo (start, step, end, intensities). Y como se indica en las 
condiciones se usa radiación CuKα  de longitud de onda 1.5418740 å, por lo que aceptaremos 
la sugerencia del cuadro de detalles del experimento. 

Veremos el difractograma de muestra:

Puesto  que  tenemos  información  adicional  respecto  a  la  composición,  podemos  abrir  el 
cuadro de restricciones mediante. Ctrl. + R.   Menú Search > Restraints.   

O el botón de acceso directo a restricciones “Restraints”

La información de esta muestra dice que contiene Pb, S, O trazas de carbono y H, por tanto 
usaremos las restricciones de los elementos para enfocarla. Es razonable pensar que el  Pb 
ESTÄ presente en cualquier compuesto que se genere; el resto de los elementos (S, O, C, H) 
PUEDEN estar presentes y NO EXISTE ninguno mas de la tabla. Según nuestro mecanismo 
de búsqueda el plomo debe marcarse en verde, los otros elementos en amarillo y el resto de la 
tabla en rojo. 
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Un consejo, lo primero que haremos es marcar toda la tabla en rojo (usando el botón “Toggle” 
y después cambiar los colores de los pocos elementos considerados.

La cantidad de entradas disponibles con nuestras 
restricciones es de 277; al aceptar las cargaremos 
desde la base de datos a la lista de resultados.  A 
partir  de  ese  momento  Match  solo  considerará 
esos patrones, hasta que no se le ordene efectuar 
otra búsqueda. Recuerda que si usas otra base de 
datos que no sea PDF2_49 el número de entradas 
puede ser diferente.

Al aceptar podremos ver en la lista de resultados 
las  primeras  entradas,  pero  si  no  iniciamos  el 
proceso de cotejo “Search Match” no tendremos 
valor  FoM  (indica  n.a.  de not avaiable)  el  color 
además  estará  en  azul  para  todas  la  entradas, 
obsérvese en el círculo.
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Otra cuestión importante es que si has observado el difractograma verás que el 
intervalo de medida  es prácticamente entre 0º y 90º, por lo tanto es necesario 
restringir  la  comparación  de  nuestros  patrones  a  ese  intervalo,  para  ello 
usaremos del botón  “Restrinc to experimental range” y…

…seguidamente iniciamos el proceso de cotejo de los patrones mediante el ya 
conocido  “Search match”.  Con ello  se muestran los patrones cotejados y  los 
valores de  FoM,  vemos que el mas coincidente es un oxido de plomo con un 
0.8633 de valor.

Podemos ir  visualizando mediante una selección simple (señalar  con el  ratón) las distintas 
especies  de  la  tabla  de  resultados,  además  debemos  observar  la  lista  de  picos  y  la 
coincidencia con los picos del difractograma. Parece ser que la primera especie está claro que 
es un OXIDO DE PLOMO, pero es evidente que al menos existe algo de sulfato de plomo, la 
especie con más probabilidad es la 00-023-0333 correspondiente a Pb5O4SO4.

Observamos  que  hay  muchos  picos  que  no  tienen 
coincidencia con los experimentales, por ejemplo a 12.09, 
14.26, 15.12, 16.17, 16.32 …etc. Esto se observa porque 
en esta lista aparecen marcados con fondo  en ROJO.

Además  en el  gráfico  podemos  ver  que no  existe  una 
línea que conecte la barra que indica la posición del pico 
de  la  PDF  (pequeñas  líneas  en  rojo  bajo  el  eje  de 
abscisas)  y el pico del difractograma. (pequeñas líneas 
en azul bajo el eje de abscisas)
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La lista de resultados abre  una columna encabezada con la  referencia  del  patrón que se 
compara, en esta generalmente se muestra la intensidad de cada pico y el fondo de su casilla 
coloreada el color VERDE indica que el pico del patrón ha sido correlacionado con un pico del 
difractograma, cuanto mas intenso es el color mejor correlación, el color verde se degrada 
hasta un gris cuanto peor es la coincidencia. El color  ROJO indica que no se ha reconocido 
coincidencia alguna. 

Si situamos el ratón unos instantes sobre la intensidad aparecerá una llamada con el valor del 
ángulo si el pico ha sido correlacionado.

Por ejemplo en el patrón 00-023-0333 el pico de 
intensidad 87.5  tiene un valor 2θ de 10.75, por 
lo  que  ha  sido  relacionado  con  el  pico  de  la 
muestra  de  ángulo  10.78  e  intensidad  66.5. 
Sobre las intensidades de las casillas rojas no 
aparece la llamada

Sobre el gráfico podemos usar el “zoom para ampliar la zona correspondiente al ángulo 12.09,

Se aprecia un pico del difractograma y el pico del patrón pero no se ha establecido correlación, 
sencillamente porque en el proceso de cotejado no había suficiente sensibilidad para detectar 
el pico de la muestra.

Para corregir este problema tendremos que aumentar la sensibilidad de la búsqueda de picos, 
podemos hacerlo de varias maneras:
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Mediante el menú  Pattern > Peak searching > Increase sensitivity 
también existe la posibilidad Pattern > Peak searching > Decrease sensitivity 
o bien de manera automática  Pattern > Peak searching > Optimize sensitivity

Estas acciones también llevan asociadas las teclas de función F2, F3 y F4.

Podemos usar F4 es decir ir a una sensibilidad de búsqueda óptima, podemos incluso volver 
a ejecutar “search match”  veremos como aparecen muchas más coincidencias:

• En el diagrama 
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• En la lista de resultados

• Y el valor de la FoM aumenta 

Para apreciar  los picos con detalle  tendremos que usar las utilidades de ampliación de la 
pantalla que están recogidas en la barra de botones situada a la izquierda del gráfico:

El botón de ampliación “Zoom” (lupa).  Al pulsarlo, el cursor cambia a la forma de una lupa y 
se  puede  “arrastrar”  por  la  pantalla  para  ampliar  una  zona.  La  zona  que  se  ampliará 
permanecerá en amarillo hasta que se relaje el botón izquierdo del ratón. Así usando zoom 
podemos ampliar una zona entre 40 y 60 º de ángulo 2θ.

Mientras  el  botón  izquierdo   del  
ratón  esté  pulsado  veremos 
amarilla la zona a ampliar de 40º a 
60º  2θ. Al relajar el botón izquierdo del ratón se muestra la zona ampliada, la abscisa  

se muestra con dos decimales, de 42.00º  a  62.00º  2θ.

Manuales del departamento de Análisis Químico – diciembre 2006 -



-  33  -

Otra utilidad similar es el cursor de ampliación y arrastre “Zoom/Track”, si se pulsa el 
ratón y se desplaza hacia arriba la imagen se amplia, si se desplaza hacia abajo la 
imagen se reduce; pero si se desplaza hacia la derecha o izquierda se desplazará 
hacia ese mismo lado todo el gráfico.

Para  volver  a la  imagen original  se puede pulsar  el  botón deshacer 
zoom “Unzoom” representado por la lupa tachada. Si se efectúa mas 
de una operación de ampliación se puede “volver al Zoom anterior” es 
la lupa con flecha azul.  

En nuestra muestra se observa mas de una fase,  evidentemente un óxido de plomo y un 
oxisulfato de plomo estarán presentes, puesto que nuestro interés es identificar fases una vez 
inspeccionadas y seleccionadas las que presenten mejor coincidencia lo lógico sería no buscar 
mas esas especies. 

Para ayudarnos tenemos la utilidad “Automatic Residual Searching” o búsqueda 
automática de residuos, se activa pulsando este botón y su misión consiste en no 
buscar picos ya asignados a una fase. Pulsemos el botón.

En nuestra muestra podemos seleccionar y “marcar como válida” (validar) la especie de mas 
probabilidad  (FoM 0.888);  un  óxido  de  plomo el  00-078-1666.  La fase siguiente  con  mas 
probabilidad  (FoM 0.8214);  es  el  sulfato  de  plomo 00-023-0333  si  lo  aceptamos veremos 
desaparecer las especies de la lista y quedar solo las dos indicadas.

 Fijémonos en los valores de la columna “Quant (%)” y veremos que 19.9 +80.1 suman 100
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Naturalmente, la búsqueda de picos residuales hace eso, buscar entre los no validados, por lo 
que  si  validamos  una  especie  cuyo  patrón  recoja  muchos  picos  quedarán  menos  picos 
disponibles para la siguiente búsqueda. El óxido de plomo deja  mas picos disponibles que el 
sulfato, por eso he tenido cuidado de validarla en primer lugar, aunque en este caso quizá 
diera igual.

Así el resultado sería en primera aproximación:

1. Oxido de plomo PbO [00-078-1666].  Aproximadamente un 20 %
2. Oxi sulfato de plomo Pb5O4SO4 [00-023-0333]. Aproximadamente un 80 %

Para acabar  el  tutorial,  se procede a  la  impresión  de resultados o se pulsa  Ctrl.  +F que 
activará el menú File > Finished y que realizará exactamente la siguiente secuencia

Quede constancia de que existen más fases identificables en esta muestra, puesto de se había 
detectado carbono e hidrógeno. 

Se propone al alumno realizar el mismo trabajo abriendo uno de los ficheros de “sample 4” 
entregados con el disquete de SMRR.  ¿Se llega a la misma conclusión?
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TUTORIAL 5: IDENTIFICACIÓN AUTOMÁTICA DE FASES

El proceso de identificación de una muestra es  el siguiente:

1. En un difractor de rayos X y con la mayor precisión y exactitud posibles se obtiene el 
“difractograma” de la muestra en estudio. El resultado de esta medida es un archivo 
que contiene la tabla de valores de intensidad de pico frente a los de ángulo 2θ y en 
algunas ocasiones información complementaria, este archivo es llamado “raw data” que 
podemos traducir por “archivo fuente”.

2. El archivo fuente se “importa” al programa. MATCH!

3. El  archivo fuente se tiene que  procesar pues el objetivo es conseguir un  perfil de 
nuestra muestra, es decir una tabla donde figuren los valores de intensidad de los picos 
frente a su posición 2θ con la mejor precisión. El gráfico generado es un gráfico de 
barras (o líneas)  de distintas alturas representadas frente a  distintas  posiciones  de 
ángulo. El proceso es el siguiente:

• Se elimina la radiación alfa 2 (si está presente)
• Se realiza una atenuamiento de picos (smoothing)
• Se realiza la sustracción del fondo
• Se buscan los picos del difractograma
• Se ajusta  y crea el perfil de la muestra.
• Se ejecutan las correcciones de errores

4. Si hay información adicional sobre la muestra se usa para establecer restricciones a la 
búsqueda  de  perfiles  de  patrones  y  usar  una  base  de  datos  razonable  para  la 
comparación.

5. Iniciar un proceso de comparación de perfiles de la base y del perfil de la muestra que 
llamamos “Search-Match” (y traduzco por cotejado);  el  grado de concordancia entre 
perfiles  se  indica  mediante  un  valor  llamado  “Figure  of  Merit”  (FoM)  que  varía  de 
0.0000 a 1.0000. Con ello el programa recomienda la comparación de los perfiles que 
tienen  un nivel  de  concordancia  superior  a  un  umbral  de  FoM preestablecido  (por 
defecto 0.6)

6. El analista DEBE DECIDIR a la vista de los resultados que perfiles son los más acordes 
al presentado por la muestra y validarlos.

7. Seguiría una etapa en la que los perfiles deben ser refinados por algún método (como 
el  Rietveld)  pero  esta  función  no está  incorporada  a  MATCH,  puede  usarse algún 
programa externo como Fullprof.

8. Se imprimen el informe y los resultados.

Por lo general es difícil pensar en un proceso automático de identificación de especies en un 
difractograma debido al  PASO 6 en el  que  EL ANALISTA DEBE seleccionar las especies 
candidatas.  Esta selección requiere una cierta práctica y experiencia en casos reales, que es 
difícil de transferir a un programa informático. MATCH aplica un algoritmo propio, en efecto; en 
algunos casos es posible aplicar un algoritmo llamado “criterio de escalera” (stairs criterion) 
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basado en las diferencias entre los valores de FoM de los patrones cotejados, que permite al  
programa tomar su propia decisión.

Realmente la búsqueda automática puede ser útil si se dan los siguientes supuestos: que la 
muestra  contenga  una  o  dos  fases  como mucho,  que la  calidad  de los  datos  fuente  sea 
excelente y que se aplique a un proceso más o menos rutinario.

Usaremos  también  un  ejemplo  del  Search  Match  Round  Robin  2002,  pero  no  usaremos 
ninguna  restricción  ni  información  adicional  de la  muestra,  e  intentaremos que MATCH la 
identifique de manera automática.

Antes de efectuar una identificación de este tipo es necesario preparar el programa por tanto 
iniciaremos un nuevo documento (seleccionamos el menú File > New) o su icono. 

Ahora usando el menú Tools > Options… 

Abriremos  la  pantalla  “Options”  que 
contiene distintas pestañas para acceder a 
la configuración del programa.

En el círculo se muestra la casilla “Save as 
defaults” activada que se abre por defecto. 

Si se hacen cambios en cualquiera de las 
opciones y se mantiene activa la pestaña 
el programa guardará los cambios para las 
sesiones  siguientes,  para  evitar  cambiar 
su  forma  de  trabajo  en  principio  LA 
DESACTIVAMOS

La pestaña “Automatic” mostrará el árbol 
que  describe  el  proceso  automático  de 
identificación de fases. 

Aquí podemos definir que tareas realizará 
el programa de manera automática tras la 
importación  del  archivo  fuente,  el 
conjunto  de  las  seleccionadas  definirán 
nuestro  procedimiento “rutinario”.

Las descripciones de su acción son las 
siguientes:

“Open “Import Pattern” dialog after program start”
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Es muy útil si se utiliza el MATCH en un proceso de rutina, en nuestro caso NO LA 
ACTIVAREMOS

“Automatic raw data processing after patter import”

Permite que MATCH ejecute todas las operaciones de  procesado de datos tras su 
importación, como las acciones a realizar son varias pueden a su vez configurarse por 
lo que tendremos que abrir con el botón “Configure…” el cuadro de diálogo
 

Por defecto dejaremos activas las tres primeras operaciones:

Eliminación de radiación K-alfa 2   “K-Alpha2 stripping (if aplicable)”

Substracción del fondo  “Background subtracction”

Atenuación de picos  “Raw data smoothing”

En  el  área  “Peak  Searching”  para  el  método  de  búsqueda  (Method:)  usaremos  el 
algoritmo “Profile fitting” en vez del “Normal” que aunque requiera mas tiempo para su 
ejecución pues es mas potente. 

Además  solicitaremos  que  la  sensibilidad  de  búsqueda  se  realice  de  manera 
automática  por lo que activaremos la casilla “Automatically optimize sensitivity”

Después  de  esta  selección  pulsaremos  OK,  volveremos  a  la  pantalla 
“Options/Automatic”  y marcaremos la casilla.
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“Display Restraints dialog after…”

Tras el procesado de datos si se marca esta casilla el programa mostrará el cuadro de 
restricciones por si queremos introducir alguna.  NO MARCAREMOS ESTA OPCIÓN.

“Search match after pattern import”

Inicia el cálculo para mostrar los patrones  de la base de datos que mas se ajustan; por 
tanto ACTIVAREMOS ESTA CASILLA.

“Select entries after search-match”

Permitirá que el programa aplique el algoritmo de decisión en función de las entradas 
seleccionadas  en  el  proceso  de  cotejado  con  la  base  de  datos  por  tanto 
ACTIVAREMOS ESTA CASILLA.

“Finish after entry selection”

Indicará al  programa la forma de acabar,  bien mostrando el  cuadro finalizar  o bien 
mostrando y permitiendo la forma en que lo haga. En este caso NO ACTIVAREMOS la 
casilla.

Así el aspecto será este:

Pulsamos OK para establecer esta rutina (en esta sesión).
 
Iniciamos la importación de datos y en el directorio tutorial seleccionaremos los datos del tipo 
Bruker/Siemens raw data (*.raw) veremos la posibilidad de abrir el archivo “session 5” y lo 
abriremos, el programa hará el resto. Veremos la pantalla
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La especie encontrada con una FoM de 0.8506 es la  Thalidomida C13H10N2O  [00-019-1946]. 
Que corresponde a la muestra “Sample 3” del SMRR.

Tenemos observar muy claramente que esta sesión del tutorial nos indica como preparar una 
rutina  para  identificación  automática  pero,  la  muestra  3  del  SMRR  ya  sabemos  que  es 
thalidomida y  lo que se nos informa es que pueden existir mezclas polimórficas, que no han 
sido detectadas.

El gráfico muestra por defecto y superpuestos el difractograma  experimental (experimental 
pattern), el difractograma calculado tras la atenuación de picos  (Calculated pattern), el perfil 
de picos deducido (líneas en azul) y el perfil de la thalidomida. 

Afortunadamente   la  representación  gráfica  se  puede  simplificar  sin  más  que  activar  o 
desactivar  los botones de presentación,  son los situados a la izquierda de la  gráfica ;  las 
siguientes combinaciones muestran las posibilidades; compárense los resultados con el gráfico 
anterior.

Junto  a  los  botones de ampliación   “Zoom”  (lupa)   o  “Zoom/track”  permiten seleccionar  y 
ampliar un área concreta del gráfico. 

También se puede capturar usando el menú File >Export > Pattern graphics  y guardando el 
gráfico con una extensión como .bmp .jpeg o .wmf compatibles con los programas de office. 
Cada vez que efectuemos una captura tendremos un fichero nuevo.

Veamos algunas posibilidades de representación:
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Esa figura se obtuvo primero ampliando la zona en la que existe el perfil de la thalidomida; después 
efectuando la selección de botones mostrada.

Esta  última  figura  está  ajustada  al  perfil  del  patrón  encontrado,  vemos  que  hay  11  picos 
determinados que corresponden a la thalidomida (en rojo) especie que evidentemente existe 
pero el  perfil  que se ha obtenido de la  muestra  (azul)  contiene 59 picos.   Consecuencia, 
aunque el proceso automático pueda identificar alguna especie será siempre el analista el que 
deba tomar la correspondiente decisión.
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TUTORIAL 6:  “DATABASE MANAGER”

Se ha mencionado que la identificación de especies requiere el uso de bases de datos de 
patrones de difracción. Típicamente se utilizan las PDF editadas por ICDD. La gran cantidad 
de entradas contenidas permiten identificar fases inicialmente desconocidas. No obstante es 
posible que en un momento dado se quiera disponer de una base propia del usuario, creada a 
partir  de  nuestros  propios  difractogramas.  En  Match  puede  hacerse  usando  “Database 
Manager” Los patrones pueden provenir de muy distintas fuentes:

• Publicados en la literatura
• Compuestos medidos en nuestro propio difractómetro.
• Calculados de datos de estructura del  cristal (ej. Archivos .CIF).
• La base de datos de un compañero.
• Datos de picos extraídos de un archivo fuente.

ATENCIÓN: Para usar el gestor de base de datos desde Windows NT, 2000, XP o superior 
tendremos que trabajar con derechos de administrador del sistema.

CREACIÓN DE UNA BASE DE PATRONES PROPIA O DEL “USUARIO”

El programa principal para la creación de las bases de datos propias se llama 
“User  Database  Manager”.  Puede  abrirse  mediante  las  teclas  CRTL+U, 
seleccionando  el  comando  “Tools/User  database  Manager”  en  la  barra  de 
menús o mediante el botón correspondiente de icono un bote amarillo.

Si se ha optado por indicar al programa que se trabajará con bases propias antes de proceder 
al  indexado,  el  Match habrá  creado un subdirectorio  para  alojar  los datos,  de  lo  contrario 
aparecerá el siguiente aviso:

Que nos permite crear un 
subdirectorio para nuestras 
propias bases de datos al 
pulsar OK, de hecho abre 
el siguiente cuadro:

Usando el botón marcado se abre este 
cuadro  que  permite  nombrar  y  crear 
subdirectorios  en  la  ruta  que 
queramos.

En el  caso mostrado se han creado por este  
procedimiento dos  subdirectorios  DTB-USER 
y Tutorial 01 desde C:\Archivos de programa 
a\Match!
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Si no creamos ningún subdirectorio por defecto se situará en C:/Archivos de programa/Match! 
lo que nos es conveniente para nuestro tutorial.

Una vez creado el directorio se abrirá el “Gestor de bases de usuario” su interfase es esta:

CREACIÓN DE UNA BASE PARTIENDO DE DATOS BIBLIOGRÁFICOS DE DIFRACCIÓN

En la bibliografía encontramos la siguiente ficha:

Title: Common Salt
Formula Sum: NaCl
Cemical name: Sodiumcloride
Mineral name: Halite

List of peaks:
d. Int.

3.2447 82.5
2.8100 1000.0
1.9870 616.9
1.6945 17.7
1.6224 186.5
1.4050 76.8
1.2893 7.9
1.2567 192.4
1.1472 134.3
1.0816 8.1
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Información para cada entrada; sample, 
formula sum  y  name se introduciran  o 
editarán desde la pestaña “General”

Lista de entradas, aquí 
aparecen las entradas 

Pestañas, los valores, texto 
y detalles de cualquier 
entrada  pueden editarse en 
la correspondiente pestaña

Barra de botones de acciones básicas;  Add e 
Import iniciaran el proceso de creación de 
entradas

En este espacio se desplegarán las 
pestañas 
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Podemos crear  una base sencillamente  introduciendo  manualmente  los  datos  mediante  el 
“User Database Manager” (que podemos nombrar de aquí en adelante como UDM) Para ello 
lo abrimos y hacemos clic en el botón “Add” 

Automáticamente en el  espacio inferior  veremos activada la  pestaña “General”  y el  cursor 
dispuesto en el campo “Sample name” del cuadro Phase description este cuadro contiene los 
cuatro campos que se usan para la identificación de una entrada en la “Lista de entradas” 
Introduciremos  los  datos  correspondientes  al  nombre  de  la  muestra,“Common  Salt”,  y 
pulsamos el tabulador (Tab) para avanzar al campo siguiente “Formula sum:” 

ATENCIÓN: debemos introducir la fórmula del cloruro sódico, pero usaremos la convención de 
nombres utilizada en los archivos CIF o PDF-standard, que requiere escribir un  espacio en 
blanco entre Na y Cl, de todas formas si nos olvidamos saltará un cuadro de aviso

Pulsamos Tab para avanzar de campo y rellenamos los dos siguientes, por último clicaremos 
sobre el botón *(excelent) del campo Quality para definir la calidad del patrón (por defecto está 
definida en B(none) ya que no se conocen datos.  Si lo hemos hecho bien el aspecto será este:

Para introducir los valores de la bibliografía de nuestra lista de picos, tendremos que abrir la 
pestaña “Diffraction pattern” (el aspecto cambia) y en el cuadro de la derecha clicar donde 
dice “Clik here to add Peak” bajo el encabezado d(Ángstrom) y en la zona resaltada de azul.
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Introducimos  el  valor  de  d  del  primer  pico  y  nos 
desplazamos al campo siguiente mediante el tabulador, 
que  nos  permite  escribir  la  intensidad;  pulsamos  de 
nuevo  el  tabulador  y  avanzaremos  para  introducir  el 
valor de d del segundo pico y así sucesivamente con 
todos. Al finalizar la última entrada acabamos pulsando 
el  tabulador  y  a continuación  el  botón “Accept”  para 
fijar  los  datos;  en  el  cuadro  de  la  izquierda  irán 
dibujándose  automáticamente  las  líneas  de  nuestro 
patrón.

Proceso  de  llenado;  los  campos  se  activan 
pulsando el tabulador

Por último en el cuadro general salvaremos el patrón pulsando Save changes 
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ICDD PDF. No se puede cambiar por 
el usuario
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El patrón recibe un número, empezando por 99-900-0000 según las reglas de ICDD PDF, que 
no se puede alterar por el usuario.

Solo falta guardar la base de datos; podemos hacerlo sencillamente al salir del UDM pulsando 
en el botón  en cuyo caso obtenemos este aviso:

¿Desea usar la base de datos nueva (o modificada) a partir de ahora?

Tome nota que si contesta “Yes” se procederá recalcular el archivo indexado, si responde  
“No”, guardará su base de datos para poder restaurarla en un futuro

Por el momento contestamos que “No”, lo que nos permite abrir un cuadro de directorios y 
nombrar nuestra base de datos. 

He  elegido  para  nuestra  ruta  C:/Archivos  de  programa/Match/Tutorial/  y  como  nombre 
User_dbtutorial la extensión de estos archivos es .Match! user database (*.mtu). por lo que 
nuestro archivo se guardará con esa extensión.

C:/Archivos de programa/Match/Tutorial/ User_dbtutorial.mtu

ENTRADA MANUAL DE DATOS DE ESTRUCTURAS CRISTALINAS

Si una publicación no contiene los datos de difracción es posible que contenga los datos de la 
estructura  cristalina  de  la  fase,  UDM  puede  incorporarlos  y  transformarlos  en  datos  de 
difracción.  El  ejemplo  que  incorporaremos  será  un  cuarzo  cuyos  valores  de  la  estructura 
cristalina se recogen en una publicación científica; la ficha es la siguiente:

Title: Alpha-quartz

Formula Sum: SiO$_2$

Cemical name: Silicondioxide

Mineral name: Quartz

Cristal structure data

Cristal system: Trigonal
Space group: P 32 2 i

Unit cell: a = 4.914        c = 5.405
alpha = 90.0   gamma = 120.0

Atomic coordiantes:

Si   0.4698 0.0000 0.6667
O   0.4145 0.2662 0.7856

Reference:
G.Smith, L.E. Alexander, Acta Cryst. 16(6), 462 (1963)
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Introduciremos estos datos en el siguiente orden 

Abriremos UDM, pulsaremos sobre Add para generar una nueva entrada y comprobaremos 
que la pestaña General se despliega y el cursor se situa en el campo “name”, de la manera 
que ya sabemos introduciremos los nombres en los campos, recordando la necesidad de dejar 
un espacio en blanco al introducir los componentes de la fórmula, escribiremos para ello “Si 
O2” la calidad del difractograma la evaluaremos como “C (calculated)” pues el difractograma 
será calculado a partir de datos cristalográficos.

Ahora pulsaremos en la pestaña “Crystal Structure”. 

Como el  cristal  es trigonal activaremos la casilla  “Hexagonal/trigonal”  en el  cuadro “Crystal 
sistem”. 

Usaremos  la  combo  box  para  seleccionar  el  grupo 
espacial; la información nuestra dice que es el “P 32 2 1”.

Desplegando la información del campo seleccionaremos el 
valor  P  32  2  1  (154),  el  número  entre  paréntesis 
corresponde  al  dado  en  las  tablas  internacionales  de 
cristalografía

Después,  y no antes, de seleccionar el sistema cristalino y el grupo espacial, introduciremos 
los datos de los parámetros de la  celda del cristal, los valores a: y c: estarán resaltados y para 
acceder a los campos podemos usar el tabulador, tras colocar los valores de a  y c el siguiente 
campo activo es el de los parámetros de los átomos.

El primer átomo es Si, los valores se activarán para X(introduciremos 0.4689),Y(introduciremos 
0.0),Z(introduciremos  0.6667),  y  como  no  hay  datos  para  el  factor  de  desplazamiento 
isotrópico (Bi) ni para el factor de ocupación (Occ) pulsaremos el tabulador, los valores por 
defecto  serán 1.0  en ambos casos y  alcanzaremos el  campo  Element para  introducir  los 
valores del oxígeno. Al terminar pulsaremos el botón “Accep atom”  
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Para transformar los datos abriremos 
la  pestaña  “Diffraction  pattern” 
observaremos el siguiente mensaje…

…que naturalmente aceptaremos

El programa calcula los datos correspondientes a las reflexiones de los picos del difractograma 
y los muestra en la pestaña.

Ahora en la pestaña correspondiente a Properties / Bibliography podremos introducir los datos 
de la publicación bibliográfica. El primer campo es el del autor escribiremos los nombres G. 
Smith y L.E. alexandre, pulsaremos el tabulador para pasar al campo Journal y al escribir Acta 
Cr el  nombre  se  autocompleta  a  Acta  Crystallogr.  Pulsamos  el  tabulador  y  aparecerá  en 
CODEN:  ACCRA9 que es el códico de esta publicación, seguimos usando el tabulador para 
rellenar el volumen pagina y año.

Por último pulsamos sobre el icono de la calculadora y observaremos que aparece el valor 
3.885979 g/cm3 como valor  de densidad calculada,  importante para la localización de este 
patrón. Solo resta salvar los cambios para ver como aparece la entrada del patrón en nuestra 
base de datos.
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CALCULO DE PATRONES PARA ESTRUCTURAS CRISTALINAS IMPORTADAS DESDE 
UN ARCHIVO .CIF

Los  datos  de  las  estructuras  de  los  cristales  pueden  obtenerse  mediante  algún  archivo 
informático,  éstos  archivos  tienen  la  extensión  .CIF,  consecuentemente  podemos  importar 
nuestros  datos  sin  necesidad  de  realizar  ninguna  entrada  manual,  esto  evita  errores  de 
trascripción. 

Para ver un ejemplo abramos el UDM, después pulsaremos sobre el botón 
“Import”
Abriremos un cuadro  de directorios  que permite seleccionar  desde el  tutorial  de  Match el 
archivo  calcite.cif,  en  el  momento  de  abrirlo  y  tras  unos  segundos  puede  verse  que  el 
programa genera automáticamente la entrada.

Y podemos comprobar que todos los datos se colocaron en los campos de las diferentes 
pestañas y solo queda guardar los cambios. Este archivo .CIF fué tomado desde el American 
Mineralogist  Crystal  Structure Database  http://www.geo.arizona.edu/AMS/amcsd.php aunque 
sus datos correspondientes al grupo espacial fueron modificados al convenio actual.

ENTRADAS OBTENIDAS DESDE BASES DE OTROS USUARIOS

Si  hay  más  de  un  usuario  del  programa  Match  es  lógico  pensar  que  puede  compartirse 
información,  particularmente la concerniente a bases de datos de patrones generados con 
datos propios. Esto es fácil de realizar con el UDM, pues el programa puede añadir entradas a 
nuestra base de datos desde otras bases de datos generadas con Match, por ejemplo la de un 
colega

Abriremos el  UDM. El primer paso es efectuar un backup de la base de datos de nuestro 
colega pulsando el botón “Import”.
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Se abrirá un cuadro de diálogo para seleccionar  el  directorio  donde se encuentre la base 
donante, en este caso en …\Tutorial. Las bases de datos de usuario tienen la extensión .mtu 
(Match! user datbase)y por lo tanto el tipo de archivo que tendremos que seleccionar es este, 
podremos ver disponible la colleague_database.mtu

Para incorporarla basta con pulsar Abrir. Aparece el aviso de que el número de entradas de la 
base donante se ha incorporado a las de nuestra base. 

El  mensaje  indica  que  se  han 
importado 9 entradas desde esa 
base,  se  pulsa  OK  y  las 
entradas aparecerán en la lista 
de entradas. Observaremos que 
la  importación  asigna  números 
de entrada de forma automática 
(no modificables por el usuario) 
y  la  base  de  datos  nuestra 
aumenta en 9 entradas.

Si estuviéramos trabajando con 
una  base  de  datos  estas 
entradas  se  unirían  a  nuestra 
base  con  los  números 
adecuados
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AÑADIR UN DIFRACTOGRAMA EXPERIMENTAL 

Otra opción para añadir  un patrón de difracción a nuestra base de datos es la  de añadir 
nuestro propio difractograma experimental. Pero esta operación no se realiza desde UDM sino 
desde la ventana principal  de Match.  Cuando se obtienen los picos de difracción bien por 
haberlos calculado desde un difractograma experimental  o por importarlos de un archivo de 
picos podemos incorporar a nuestra base de usuario este patrón como una entrada mediante 
el menú File > Export > Peaks to user database. 

Por ejemplo en nuestro caso se tiene abierto el difractograma 
CR800_2.raw, se calculan los picos (basta con pulsar CTRL+P) 
y se realiza la secuencia de menús mostrada en la figura.

La  respuesta  el  cuadro  de 
diálogo “Supplementary Data” 
que  permite  introducir 
información  adicional  sobre 
nuestra  muestra,  referente  al 
nombre fórmula y mineral.

Al aceptar, la información y los datos se almacenaran en un buffer de memoria de entradas 
para el UDM, de manera que la próxima vez que se abra, el programa preguntará si estos 
datos se incorporan como una entrada más.
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Al  abrir  de  nuevo el  UDM match 
pregunta si la entrada almacenada 
en la memoria se añade a la base 
de usuario, si se acepta podremos 
ver  la  entrada  y  los  picos  y  el  
patrón en la ficha correspondiente.  

Recuerda  que  la  lista  de  picos 
posiblemente  marque 2θ frente a 
intensidad y por defecto verás (d) 
frente a intensidad (I)  para ver la 
figura  del  patrón  selecciona  la 
adecuada abscisa (2θ).

Como se ha mencionado una base de usuario nueva o modificada tiene que activarse antes de 
poder usarse. Este truco se ha introducido en el programa para evitar el tener que repetir la 
indexación. Así se puede trabajar con la base de patrones que permiten la identificación (por 
ejemplo PDF2) mientras se confecciona una base de usuario adecuada. Cuando pensemos 
que nuestra base de usuario tiene las adecuadas entradas, en el momento de abandonar UDM 
(Quit) y a la pregunta que realiza el aviso…

¿Desea usar la base de datos nueva (o modificada) a partir de ahora?
Tome nota que si contesta “Yes” se procederá recalcular el archivo indexado, si 
responde “No”, guardará su base de datos para poder restaurarla en un futuro

…podemos contestar “Si”; el programa volverá a indexar todas las bases presentes, primero 
leerá PDF2 después la base de usuario y por último creará el índice.

Al finalizar aparece el aviso de que 
el  indexado  está  completo  y  el 
programa puede usarse. 

En  este  momento  tendremos  una 
base  de  datos  particular  operativa 
desde el momento en que se abre 
Match!

Es importante el saber que durante las sesiones y al finalizar el trabajo con el UDM dependerá 
de las opciones de guardado que  se escojan para que al abrir Match! se proceda a indexar de 
nuevo las bases de datos. 

Así  mismo,  los  botones  “Restore” y  “Backup” tendrán  la  función  de  abrir  y  guardar, 
respectivamente, la base de usuario; Restore puede recuperar la base en la que hubiésemos 
trabajado la última vez.
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AÑADIR UN DIFRACTOGRAMA CONTENIDO EN LA PDF2 O PDF4

Match! puede cotejar prácticamente toda 
la base de datos PDF2 o PDF4, lo que 
supone mas de 100.000 entradas, por lo 
que  no  es  necesario  preparar  ninguna 
base parcial.

Dentro  de  restricciones  se  encuentra 
“Database/Subfiles”  que  permite 
restringir  la  búsqueda  y  cotejo  a  una 
categoría  de  archivos  extraídos  de  la 
base general (Battery,Material, Ceramic, 
etc.) 

En el momento de iniciar la identificación 
de  nuestra  muestra,  solo  cotejará  los 
seleccionados.

No obstante puede que para completar nuestra base de usuario pudiera ser interesante incluir 
algún patrón. Tenemos una posibilidad para ello, introducir los datos manualmente tal como se 
indicó, pues tendremos la lista de picos y suficiente información complementaria además la 
estructura de la ficha permitirá rellenar los campos de UDM con facilidad. 

Veamos un ejemplo.  Supóngase que tras una búsqueda el  difractograma experimental  (en 
azul) se ajusta bastante bien con una entrada  la 00-078-00546 (un óxido de níquel y galio con 
estructura de espinela) cuyos picos están marcados en rojo.
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Para recoger los datos de la entrada tenemos algunas posibilidades, veamos la figura:

como se muestra en ella, podemos generar y guardar un archivo con los valores de los picos 
(pasos  1,  2,  4);  éste  tendrá  extensión  *.dif,  se  puede  guardar  en  disco  y  posteriormente 
insertarse directamente en un editor de texto. El resultado sobre Word es este:

# PDF entry 00-078-0546 Copyright International Centre for Diffraction 
Data (ICDD)
  4.769490    84.0
  2.920700   321.3
  2.490790  1000.0
  2.384750    92.0
  2.065240   154.1
  1.895200     2.0
  1.686270    91.0
  1.589830   274.2
  1.460350   318.3
  1.396360     5.0
  1.376830     1.0
  1.306170    28.0
  1.259790    63.0
  1.245390    29.0
  1.192370    14.0
  1.156770     3.0
  1.103920    28.0
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1 El difractograma ha sido 
importado y cotejado  y se ajusta 
bien a una entrada.

2 La  entrada  seleccionada  es  00-78-0546,  se 
marca y se puede ver su ficha PDF al pulsar el botón 
marcado con el círculo

3 Si se opta por la 
impresión se obtendrá  la ficha 
completa de la entrada

4 Si se opta por exportar 
el patrón de referencia se 
obtendrá un archivo (.dif) que 
puede insertarse en un editor de 
texto
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La columna primera es valor de d (å ) y la segunda intensidades, desde aquí se puede generar 
manualmente  la  entrada con UDM.   Obsérvese como la  impresión recoge el  copyright  de 
ICDD.  

Pero también podemos seleccionar una entrada y proceder a imprimir su ficha (pasos 1, 2, 3) 
esto nos proporcionará más información suplementaria para introducir en lasa pestañas del 
UDM. Véase ficha adjunta.
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